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Read this manual carefully before you use this product and keep it handy for future reference.



Introduction

This manual describes basic instructions and notes about the use of this product. To get maximum ver-
satility all operators are requested to read this manual carefully and follow the instructions. Please keep
this manual handy for future reference.

Trademarks

Windows is registered trademarks of Microsoft Corporation, in the United States and other countries.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.
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How to Read This Manual

Symbols

In this manual, the following symbols are used :

Important
This symbol indicates a situation that may result in property damage or mal-
function if instructions are not followed. Be sure to read the instructions.

Preparation
This symbol indicates information or preparations required prior to operating.

Note
This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Elements on the machine's display panel or the computer's display, such as keys,
buttons, and menus.



2
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When ScanRouter DocumentServer is used for document management, docu-
ments are stored and managed in the cabinets of the document management
server.
Documents added using DeskTopBinder Professional or ScanRouter Web Nav-
igator are sorted for each folder created in the cabinet, and then stored and man-
aged. Added documents can be shared among multiple client computers to be
viewed and handled using DeskTopBinder Professional or ScanRouter Web
Navigator.
Also, ScanRouter DocumentServer can manage user authentication settings col-
lectively using Authentication Management Service. For user authentication,
you can specify Windows Authentication (NT compatible), Windows Authenti-
cation (native), or Basic Authentication. Authentication Management Service is
possible using Authentication Manager.
This manual explains basic operations for adding a document to ScanRouter
DocumentServer (document management server).

Operational Flow

Firstly, access Authentication Management Service using Authentication Man-
ager, and then register users.
Secondly, create cabinets where documents are stored using SRDS Manager un-
der the registered user.
Finally, add documents to each cabinet using DeskTopBinder Profession-
al/ScanRouter Web Navigator.
Follow the procedure described as an example of specifying Basic Authentica-
tion for the user authentication.
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1.  Add a user. See p.5 “Using Au-
thentication Manager”.

2. Create a cabinet for adding docu-
ments. See p.11 “Using ScanRouter
DocumentServer”.

3. Add documents to the cabinet cre-
ated in step 2. See p.19 “Client Oper-
ations”

AEL001S

Start SRDS Manager

Set ScanRouter DocumentServer Administrator

Quit SRDS Manager

ScanRouter DocumentServer SRDS Manager

Start Authentication Manager

Add Basic Authentication user

Authentication Manager

Create cabinets

Start SR Web Navigator Manager

Set ScanRouter Web Navigator administrator

Log in to ScanRouter Web Navigator (Web Browser)

ScanRouter Web Navigator

Add documents

Add users

Set services (Document management service)

Set destinations of connection

Start DeskTopBinder Professional

Extended Features

Add cabinets

DeskTopBinder Professional

Add documents

1
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Registering Basic Authentication User

This section explains operating procedures when Basic Authentication is used as
the authentication method.
Start Authentication Manager to operate Authentication Management Service,
and register a Basic Authentication user.

AAAA On the [Start] menu, point to [Program], point to [ScanRouter System], and then
click [Authentication Manager].

The [Login] dialog box appears.

BBBB Click [Basic Authentication] on the [Authentication:] tab, and then enter "Ad-
min" in [User name:] and the built-in user password specified during instal-
lation in [Password:].
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CCCC Click [OK].

Authentication Manager starts.
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DDDD Click [Add/Delete Basic Auth. User].

The [Add/Delete User] dialog box appears.
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EEEE Click [Add User...].

The [User Property] dialog box appears.

FFFF Enter a user name and password, and then click [OK].
An additional confirmation dialog box appears.
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GGGG Click [OK].

The [Add/Delete User] dialog box reappears. When [Users] under [View:] is se-
lected, the list of added users is displayed.

HHHH Click [Close].

IIII Click [Exit].

Authentication Manager quits.

AEL020S
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Creating Cabinets Using SRDS Manager

Follow the procedure below to create cabinets in the document management
server, in which documents can be stored. 

AAAA On the [Start] menu, point to [Programs] > [ScanRouter System] > [ScanRouter
DocumentServer], and then click [SRDS Manager].

The [Select Server] dialog box appears.

BBBB Enter the name of the server where cabinets are created, and then click [OK].
The [Login] dialog box appears.
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CCCC Enter the built-in user name (Admin) in [User:] and the built-in user pass-
word specified during installation in [Password:], and then click [OK].

SRDS Manager starts.



Creating Cabinets Using SRDS Manager

13

3

DDDD Make the following settings for the ScanRouter DocumentServer Admin-
istrator:

A On the [Server] menu, click [Set Administrator].

The [Set Administrator] dialog box appears.
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B Click [Users] on the [View:].

A list of users appears.
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C Select the user you want to specify as the administrator, and then click
[Add >].

AEL021S
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The selected user is displayed in [Members:].

D Click [OK].

The selected user is specified as the ScanRouter DocumentServer Admin-
istrator.
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EEEE Log in to the server again under the administrator specified in step DDDD.

A On the [Server] menu, click [Login as another User].
The [Login] dialog box appears.

B Enter the user name and password for the administrator specified in step
DDDD, and then click [OK].

FFFF Create a cabinet.
A In the tree pane, click [Cabinet].

AEL022S
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B On the [Operations] menu, click [New Cabinet].

The [New Cabinet] dialog box appears.

C Enter a name in [Cabinet name:], and then click [OK].

The dialog box appears, notifying you that a cabinet has been created.
D Click [OK].

The created cabinet is displayed in [Cabinets].

GGGG On the [Server] menu, click [Exit].
SRDS Manager quits.
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Adding Cabinets and Documents

Follow the procedure below to add cabinets created in “Creating Cabinets Using
SRDS Manager” using DeskTopBinder Professional or ScanRouter Web Naviga-
tor, and then add documents to them.

Using DeskTopBinder Professional

Adding Cabinets

Follow the procedure below to add ScanRouter DocumentServer Cabinets.

AAAA On the [Start] menu, point to [Programs], point to [DeskTopBinder], and then
click [DeskTopBinder].

DeskTopBinder Professional starts.

BBBB On the [Tools] menu, click [Extended Features...].

The [Extended Features] dialog box appears.
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CCCC Click [Network] in [Type:].

The network list is displayed in [Selectable function(s):].



Adding Cabinets and Documents

21

4

DDDD Click [ScanRouter DocumentServer V2] in [Selectable function(s):], and then click
[Add].

The [Document Management Server Properties] dialog box appears.

EEEE Click [Browse...] for the [Server:].

The [Browse for Document Management Server] dialog box appears.

AEL002S
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FFFF Select the server to be connected, and then click [OK].

The [Document Management Server Properties] dialog box reappears. The select-
ed cabinet is displayed in the list.

GGGG Click [Add...] under [Server cabinet(s) added to Tree:].
The [Enter Password] dialog box for the selected server appears.

HHHH Enter a user name and password, and then click [OK].

The [Add Cabinet on Document Management Server to Tree] dialog box appears.

AEL003S



Adding Cabinets and Documents

23

4

IIII Select the cabinet you want to register from the cabinet list, and then click
[OK].

The [Document Management Server Properties] dialog box reappears.
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JJJJ Click [OK].

The [Extended Features] dialog box reappears. The server selected in step F is
displayed in the [Available function(s) to use:] list.

AEL004S
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KKKK Click [OK].

The registered ScanRouter DocumentServer is displayed in the DeskTop-
Binder Professional tree pane.

Adding Documents

Follow the procedure below to create a folder in the registered ScanRouter Doc-
umentServer cabinet and add documents to it.
Documents can be added by various methods. This section explains adding doc-
uments registered in DeskTopBinder Professional and Windows files.

AAAA Create a folder in the cabinet.
A Select a cabinet registered in the ScanRouter DocumentServer tree pane.

AEL005S

AEL006S
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B On the [File] menu, click [Create New Folder].

A new folder is created under the cabinet.

C Enter the folder name.

BBBB Copy the document registered in DeskTopBinder Professional or the Win-
dows file, and then add it to the folder created in step AAAA.

Adding DeskTopBinder Professional documents

A In the tree pane, select [Sample Folder] under [My Workroom] under [My Cab-
inet].

AEL007S

AEL008S



Adding Cabinets and Documents

27

4

B Select a document in the folder, and then click [Copy...] on the [Edit] menu.

The [Copy Document] dialog box appears.

C Select a ScanRouter DocumentServer folder in [Copy to:], and then click [OK].

The selected document is copied and stored in the folder.

AEL009S
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Adding windows files

A Open Windows Explorer.
B Select the file you want to add, and then drag and drop it to the Scan-

Router DocumentServer folder in the DeskTopBinder Professional tree
pane.

C On the pop-up menu that appears, click [Copy Here].
The selected document is copied and stored in the folder.

AEL010S
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Using ScanRouter Web Navigator

Specifying Administrator of ScanRouter Web Navigator

Start SR Web Navigator Manager, and then specify a ScanRouter Web Navigator
servers administrator.
Log on to ScanRouter Web Navigator under the administrator specified here to
make default settings.

AAAA On the [Start] menu, point to [Programs], point to [ScanRouter System], point
to [ScanRouter Web Navigator], and then click [SR Web Navigator Manager].

The [Select Server] page appears.

BBBB Click [Browse] to display [Browse Server] page, and then select the servers to
manage.

CCCC Click [OK].

The [Select Server] page reappears.

AEL023S
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DDDD Click [OK].

The [Login] dialog box appears.

EEEE Enter the built-in user name ("Admin") and the password.

FFFF Click [OK].
SR Web Navigator Manager starts.
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GGGG On the [Server] menu, click [Set Administrator].

The [Set Administrator] page appears.



Client Operations

32

4

HHHH Click [User] on the [View].

Users are displayed in the [Name] list.

AEL024S
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IIII Select a user in the [Name] list to specify the administrator, and then click
[Add].

To remove the administrator in the [Name] list, select it, and then click [Re-
move].
The user can also be searched for and added by clicking [Search].

JJJJ Click [OK].

AEL025S
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Adding Users

Follow the procedure below to log on to ScanRouter Web Navigator, and then
add users who can use it.

AAAA Start a Web browser, and then enter the ScanRouter Web Navigator URL in
[Address].

The ScanRouter Web Navigator login page appears.
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BBBB Enter the user name and password for the administrator set in "Specifying
Administrator of ScanRouter Web Navigator", and then click [Login].

The Work Links page appears.

CCCC Click the [Settings] button in the header area.

AEL011S
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The [Settings] page appears.

DDDD Click [Administrator Settings].

The [Administrator Settings] page appears.
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EEEE Click [System Settings].

The [System Settings] page appears.

FFFF Click [User Management Settings].

The [Administrator Settings: User Management] page appears.



Client Operations

38

4

GGGG On the [Add User] menu, click [Add from List].

The [Administrator Settings: Add User from List] page appears.

AEL012S
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HHHH Select a user to be added, and then click [Next].

The [Administrator Settings: Add User] page appears.

IIII Enter the settings of the user.

JJJJ Click [OK].
The [Administrator Settings: User Management Settings] page reappears.
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KKKK Check the added users are displayed in the added user list.
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Making Settings for Document Management Service

Follow the procedure below to make necessary settings for the document man-
agement service you want to use.

AAAA Use a Web browser to display the [Work Links] page of ScanRouter Web Nav-
igator.

BBBB Click the [Settings] button in the header area.

AEL011S
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The [Settings] page appears.

CCCC Click [Administrator Settings].

The [Administrator Settings] page appears.
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DDDD Click [Service Settings].

The [Service Settings] page appears.

EEEE Click [Document Management Service].

The [Document Management Service] page appears.
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FFFF On the [New Additions] menu, click [Service].

The [Document Management Service] page appears.

GGGG Click [Browse] to display [Document Management Service Server List] page, and
then select the document management server where documents are to be
added.

HHHH Click [OK].

The selected server name appears on the [Document Management Service] page.

AEL013S

AEL014S
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IIII Enter the name to be displayed, and then click [OK].

The [Document Management Service] page reappears.
Check the specified document management server is displayed in the service
list.

JJJJ Click [OK].

The [Service Settings] page reappears.
To return the [Work Links] page, proceed to click [Back].

Adding Cabinets

Follow the procedure below to add ScanRouter DocumentServer cabinets.

AAAA Use a Web browser to display the [Work Links] page of ScanRouter Web Nav-
igator.
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BBBB Click the [Setting] button in the header area.

The [Settings] page appears.

AEL011S
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CCCC Click [Connection Settings].

The [Connection Settings] page appears.
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DDDD On the [Add Cabinets] menu, click [Cabinet].

The [Connection Settings: Add Cabinet] page appears.

AEL015S
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EEEE Select the document management server to use in the list.

The [Login] dialog box for the selected server appears.

FFFF Enter a user name and password, and then click [OK].
The [Connection Settings: Add Cabinet] page reappears.
A list of the cabinets added in the document management server appears.

AEL016S
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GGGG Select a cabinet to be added as a destination, and then click [OK].

The [Connection Settings] page reappears. The selected cabinet is displayed in
the list.

HHHH Click [OK].

The [Settings] page reappears.
To return the [Work Links] page, proceed to click [Back].
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Adding Documents

Follow the procedure below to add a document to the registered ScanRouter
DocumentServer cabinet.
This section explains importing an existing file and adding it as a document.

AAAA Use a Web browser to display the [Work Links] page of ScanRouter Web Nav-
igator.

BBBB Click [Work Studio].

The [Work Studio] page appears.
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CCCC In the tree pane, select the cabinet where you want to add the document.

DDDD Click [Create document from File] on the [New] menu under [Menu].

AEL017S

AEL018S
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The [Add Document(s): Select File] page appears.

EEEE Click [Browse], for the [Select file].

FFFF Select the file to add, and then click [Open].

GGGG Click [Add].
The selected file is displayed in the [Add Section(s)].

HHHH Click [Next].

AEL019S
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The [Add Document(s): Enter Document Properties] page appears.

IIII Enter each item, and then click [OK].

The [Document Added] page appears.
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JJJJ Click [OK].

The selected file is added as a document.
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Some of illustrations or explanations in this guide may differ from your product due to improvements or
changes in the product.

Note

1. The contents of this document are subject to change without notice.

2. THE SUPPLIER SHALL NOT BE LIABLE FOR THE RESULTS OF OPERATING THIS PRODUCT
(HARDWARE, SOFTWARE) OR USING THIS DOCUMENT.

3. No part of this document may be duplicated, replicated, reproduced in any form, modified or quoted
without prior consent of the supplier.

Important
❒ It is possible that any document or data stored in the PC will be damaged or lost by user error during

operation or software error. Be sure to back up of all important data beforehand. Important docu-
ments and data should always be copied or backed up. Documents and data can be lost because
of malfunction or human error. Furthermore, the customer is responsible for protection measures
against computer viruses, worms, and other harmful software.

❒ Do not remove or insert any disk while operating this software.

❒ THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR DAMAGES OR LOSS OF ANY DOCU-
MENT OR DATA PRODUCED BY USING THIS SOFTWARE.

❒ THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL
OR INDIRECT DAMAGES (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF
PROFITS, BUSINESS INTERRUPTION OR LOSS OF BUSINESS INFORMATION, AND THE
LIKE) CAUSED BY FAILURE OF THIS SOFTWARE OR LOSS OF DOCUMENTS OR DATA, NOR
FOR ANY OTHER DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE, IF THE SUP-
PLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
Copyright © 2004
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